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1. Introduction, Features and Applications

Introduction

The DM805-AI is a 0-5V input stepper drive with built-in oscillator which is based on the latest digital control algorithm. It brings a
unique level of system smoothness, providing optimum torque and nulls mid-range instability. Motor self-test and parameter auto-setup
technology offers optimum responses with different motors and easy-to-use. The driven motors can run with much smaller noise, lower
heating, smoother movement than most of the drivers in the markets. Its unique features make the DM805-AI an ideal solution for

applications that require low-speed smoothness.

The three built-in potentiometers are used to preset and adjust the velocity, acceleration and deceleration. In 0-5V speed mode, the motor
speed is controllable and follows the analog 0-5V input. In Low/HIGH speed mode, the motor speed is selected by digital input and
adjusted by the high/low speed potentiometers. The user can run the motor with the least configuration and connection. In position mode,

the DM805-Al is a traditional stepper drive. There is a 5V power supply output for customer use.

Features

Anti-Resonance, provides optimum torque and nulls mid-range instability

Motor self-test and parameter auto-setup technology, offers optimum responses with different motors
Multi-Stepping allows a low resolution step input to produce a higher microstep output for smooth system performance
Command Source: 0-5V, built-in potentiometer and pulse

Two preset velocity and adjust by built-in potentiometer

Preset acceleration/deceleration and adjust by built-in potentiometer

Velocity control mode via analog 0-5V and position control mode via pulse

Built-in pulse generator nulls external motion controller

Supply voltage up to +80 VDC

Output current programmable, from 0.3A -5.0A(RMS)

TTL compatible and optically isolated digital input

Automatic current reduction

Over-voltage, over-current, phase-error protections

Applications

This drive is suitable for the application which needs to adjust the velocity via the potentiometer or analog 0-5V command. It can work
with the NEMA17/23/34 stepper motor to replace the brushless motor with gearbox due to its high torque and less motor noise at low
speed. If necessary, it can be used in various kinds of machines, such as rotary heat exchange, conveyor belts, transport vehicle, laser

cutters, laser markers, high precision X-Y tables, labeling machines, and so on.
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2. Specifications

General Specifications

Parameter Min Typical Max Unit
Isolation Resistance 500 - - MQ
Logic Signal Current 7 10 16 mA

Electrical Specifications

Input Voltage
Input Voltage
Drive Model Min Typical Max Unit
DMS805-AI 18 60 80 VDC
Pulse Input Frequency
Pulse Input Frequency
Drive Model Min Typical Max Unit
DMS805-AI 0 - 200 kHz
Velocity Control
Item Specification = Dead Band Resolution Min Max
0-5V Speed Mode 10 mV
Analog Input 0-5V 10 mV 0 Rev/s 25+ 0.5 Rev/s
External POT Mode 20 mV
Accel / Decel / Ramp Potentiometer 0-25 turns 10 mV 10 mV 0.5 Rev/s 250 + 1 Rev/s*
LoSpeed Potentiometer 0-25 turns 10 mV 10 mV 0 Rev/s 5+0.01 Rev/s
HiSpeed Potentiometer 0-25 turns 10 mV 10 mV 0 Rev/s 25+ 0.5 Rev/s
Operating Environment
Cooling Natural Cooling or Forced cooling
Environment Avoid dust, oil fog and corrosive gases
Ambient Temperature 0°C — 50°C (32°F — 122°F)
Operating
Humidity 40%RH — 90%RH
Environment . R
Operating Temperature 70°C (158°F) Max
Vibration 5.9m/s* Max
Storage Temperature 20°C — 65C (-4°F — 149°F)
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Mechanical Specifications
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Elimination of Heat

Driver’s reliable working temperature should be <70°C(158°F), and motor working temperature should be <80°C(176°F);

B [t is recommended to use automatic idle-current mode, namely current automatically reduce to 60% when motor stops, so as to
reduce driver heating and motor heating;

B ]t is recommended to mount the driver vertically to maximize heat sink area. Use forced cooling method to cool the system if

necessary.
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3. Connectors and Interface

The DM805-AT has three connectors, connector for digital I/O signals connections, connector for analog 0-5V signal connections and
connector for power and motor connections. The three parameters are used to preset or adjust the speed, acceleration and deceleration

ramp. They have different functions in different modes. The green indicator turns on when the drive is powered on. When error happens,

the red indicator flashes periodicity to indicate the error type.

Indicator Green: Power, Red: Fault

Potentiometers Adjusting Speed, Acceleration, Deceleration

Digital 1/O Signal Connector, 6-pin screw terminal, 3.81 mm

Analog Signal Connector, 6-pin screw terminal, 3.81 mm

Power Connector, 6-pin screw terminal, 3.81 mm space

Auto Tuning: Switch SW4 two times in one second.

RS232 communication port, RJ11, communicating PC software

Note: It is used to configure and current loop tuning, anti-resonance
tuning with the PC software. However, the drive can still work
properly without it. The DM805-AI can be fully tuned by the the

auto-tuning..

DIP switch, 8 bits, current setting, selecting microstep, operating mode
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4. Operating Mode

The DM805-AI supports four operating modes selected by the DIP switch SW7 and SW8, shown as the following table.

Mode SW7 SW8 Description
0~5V Speed on on Analog 0-5V Speed Mode
Lo/Hi Speed off on Low and High Speed Mode
External POT on off External Potentiometer Speed Mode
Pulse/Direction off off Pulse and Direction Position Mode
Analog 0-5V Speed Mode

In this mode motor speed follows the analog 0-5V input voltage. Motor speed is also proportional to the HiSpeed potentiometer.

Direction input controls the motor direction. The actual motor speed is calculated as follows:

Analog  Input Turns of HiSpeed Potentiometer

Speed(RPS) = 25%05(RPS) X —M8M—— X
pecd(RPS) (RPS) 5V 25Turns

A Motor Speed

25+0.5rps
Fully CW of HiSpeed Potentiometer
Dead Band
& Analog
Half CW of HiSpeed Potentiometer Input
P

Signal Sequence

After power-up, the DM805-AI does not response to the analog 0-5V input immediately. The Enable and Run signal should be activated
prior to the analog 0-5V input. The drive is enabled when the Enable/Disable input is unconnected and the motor shaft has holding

torque at that time. After Run signal is active, the motor speed follows the analog 0-5V input.
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High Speed
0-5V Input
Low Speed
-
Direction i
Positive Negative
e
Run/Stop
Run Stop
-
Enable/Disable —| Enable
|

Ramp Shaping

There are two potentiometers Accel and Decel for adjusting the acceleration ramp and deceleration ramp, respectively. When the input

ramp exceeds the value set by the potentiometer, the actual output ramp will be limited by the potentiometer value.

A Motor Speed

Actual Speed
Command Speed

Shaped by the Decel Potentiometer

Positive
Direction /

Negative
Direction /

/

Time

Shaped by the Accel Potentiometer

Low/High Speed Mode

In low/high speed mode, motor speed is fixed to the value adjusted by the LoSpeed or HiSpeed Potentiometer, depending on the level
of Speed input. When the Speed input is LOW level, the maximum motor speed adjusted by the LoSpeed potentiometer is Srps. When
the Speed input is HIGH level, the maximum motor speed adjusted by the HighSpeed is 25rps.
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A Motor Speed

25+0.5rps |
|
|
|
| X
HiSpeed Potentiometer !
|
|
|
|
|
|
|
|
|
|
i
Dead Band !
LoSpeed Potentiometer !
5+0.02rps X |
|
:
| Potentiometer
: >
0 25 turns

Signal Sequence

After power-up, the DM805-AI does not make the motor run immediately. The Enable and Run signal should be activated firstly. Drive
is enabled when the Enable/Disable input is unconnected. After Run signal is activated, the Speed can be applied to the drive for

low/high speed selection.

High

Speed Speed Low Speed

>
Direction Positive Negative

>
Run/Stop Run Stop

>
Enable/Disable J Enable

>
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Ramp Shaping

When motor speed switches between low and high or changes direction, the acceleration/deceleration ramp adjusted by the Ramp
potentiometer will be inserted automatically for smooth motion.

Note: Do not adjust too small or too high Ramp. Otherwise the stepper motor may stall when switching between low and high speed.

A Motor Speed Actual Speed

High Speed / \ Command Speed

Low Speed / [y

X AN g
/ \ Time
Shaped by Ramp Potentiometer

Shaped by Ramp Potentiometer

External Potentiometer Mode

In this mode motor speed follows the analog 0-5V input voltage. Motor speed is also proportional to the HiSpeed potentiometer. When

the analog input is 0-2.5V, the motor runs in negative direction. While the analog input is 2.5-5V, the motor runs in positive direction.

A Motor Speed

251ps
Fully CW of HiSpeed Potentiometer N
Dead Band
/ Analog
Input
Orps s
ov 2.5V 5V
Half CW of HiSpeed Potentiometer

-251ps
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Signal Sequence

2.5-5V Input Positive Direction

0-2.5V Input Negative Direction

Run Stop

Run/Stop

Enable/Disable J

Ramp Shaping

There are two potentiometers Accel and Decel for adjusting the acceleration ramp and deceleration ramp, respectively. When the input

ramp exceeds the value set by the potentiometer, the actual output ramp will be limited by the potentiometer value.

A Motor Speed

Actual Speed
Command Speed

Shaped by the Decel Potentiometer

Positive
Direction /

N'e gati've /

Direction A

Time

Shaped by the Accel Potentiometer

Pulse/Direction Mode

In this mode motor speed is the proportional to the pulse input frequency and motor rotary angle is controlled by the pulse counts. The

microstep can be selected by the DIP switch SW5 and SW6.
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S. Control Signal Requirement

Pulse/Direction Mode

DMS805-AI can support Pulse/Direction and CW/CCW control signal modes. In order to avoid some fault operations and deviations,

PUL, DIR and ENA should abide by some rules, shown as following diagram:

—_ tﬁ:-_ — typ— — — High Level>3.5V
[ i

1
PUL : PUL/CW
| |
| | |
| |
1 1
1
|
|

High Level»>3. 5V I I
l Low Level<0. 5V

JIR/CCW
| M
t1>5psi ]

— - Low Level<0. 5V

f T
|
1
ENA ENA

PUL/DIR CW/CCw

_.:t e
1 S
DIR L

Remark:
a)  ENA must be ahead of DIR by at least Sus. Usually, ENA+ and ENA- are NC (not connected).
b)  DIR must be ahead of PUL active edge by 5us to ensure correct direction;
c)  Pulse width not less than2.5us;
d)  Low level width not less than 2.5us.

6. Connecting the Motor
The DM805-AI can drive any 2-pahse and 4-pahse hybrid stepping motors.

4-lead Motors Connections

4 lead motors are the least flexible but easiest to wire. Speed and torque will depend on winding inductance. In setting the drive output
current, multiply the specified phase current by 1.4 to determine the peak output current.
P2
A+
A_
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6-lead Motors Connections

Like 8 lead stepping motors, 6 lead motors have two configurations available for high speed or high torque operation. The higher speed
configuration, or half coil, is so described because it uses one half of the motor’s inductor windings. The higher torque configuration, or
full coil, uses the full windings of the phases.

Half Coil Configurations

As previously stated, the half coil configuration uses 50% of the motor phase windings. This gives lower inductance, hence, lower
torque output. Like the parallel connection of 8 lead motor, the torque output will be more stable at higher speeds. This configuration is
also referred to as half chopper. In setting the drive output current multiply the specified per phase (or unipolar) current rating by 1.4 to
determine the peak output current.

P2
A+
A_
NC
B+
B NC

Full Coil Configurations

The full coil configuration on a six lead motor should be used in applications where higher torque at lower speeds is desired. This
configuration is also referred to as full copper. In full coil mode, the motors should be run at only 70% of their rated current to prevent
over heating.

P2
A+
A NC
B+

8-lead Motors Connections

8 lead motors offer a high degree of flexibility to the system designer in that they may be connected in series or parallel, thus satisfying a
wide range of applications.

Series Connections

A series motor configuration would typically be used in applications where a higher torque at lower speeds is required. Because this
configuration has the most inductance, the performance will start to degrade at higher speeds. In series mode, the motors should also be
run at only 70% of their rated current to prevent over heating.
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P2

Parallel Connections

An 8 lead motor in a parallel configuration offers a more stable, but lower torque at lower speeds. But because of the lower inductance,
there will be higher torque at higher speeds. Multiply the per phase (or unipolar) current rating by 1.96, or the bipolar current rating by
1.4, to determine the peak output current.
P2
A+ —
A_ —

B+
B-

NEVER disconnect or connect the motor while the power source is energized.

7. Power Supply Selection

The DM805-AI can match medium and small size stepping motors (from NEMA frame size 14 to 34) made by Leadshine or other motor
manufactures around the world. To achieve good driving performances, it is important to select supply voltage and output current
properly. Generally speaking, supply voltage determines the high speed performance of the motor, while output current determines the
output torque of the driven motor (particularly at lower speed). Higher supply voltage will allow higher motor speed to be achieved, at
the price of more noise and heating. If the motion speed requirement is low, it’s better to use lower supply voltage to decrease noise,

heating and improve reliability.

Regulated or Unregulated Power Supply

Both regulated and unregulated power supplies can be used to supply the drive. However, unregulated power supplies are preferred due
to their ability to withstand current surge. If regulated power supplies (such as most switching supplies.) are indeed used, it is important
to have large current output rating to avoid problems like current clamp, for example using 4A supply for 3A motor-drive operation. On
the other hand, if unregulated supply is used, one may use a power supply of lower current rating than that of motor (typically 50%~
70% of motor current). The reason is that the drive draws current from the power supply capacitor of the unregulated supply only during
the ON duration of the PWM cycle, but not during the OFF duration. Therefore, the average current withdrawn from power supply is

considerably less than motor current. For example, two 3A motors can be well supplied by one power supply of 4A rating.
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Multiple Drives

It is recommended to have multiple drives to share one power supply to reduce cost, if the supply has enough capacity. To avoid cross

interference, DO NOT daisy-chain the power supply input pins of the drives. Instead, please connect them to power supply separately.

Selecting Supply Voltage

The power MOSFETS inside the DM805-AI can actually operate with wider voltage range than the input specification. Higher supply
voltage can increase motor torque at higher speeds, thus helpful for avoiding losing steps. However, higher voltage may cause bigger
motor vibration at lower speed, and it may also cause over-voltage protection or even drive damage. Therefore, it is suggested to choose
only sufficiently high supply voltage for intended applications, and it is suggested to use power supplies with theoretical output voltage

of drive’s minimum + 10% to drive’s maximum — 10%, leaving room for power fluctuation and back-EMF.

A
— Driver Upper Input limit
— Driver Upper Input limit— 10% ~ —— Maximum Safe Rating
Safe Region Torque Heating
Speed Vibration
— Driver Lower Input limit + 10% ~ —— Minimum Safe Rating
— Driver Lower Input limit
Driver Input Voltage Power Supply Voltage

The recommended power supply voltage for DM805-AI is 24-72VDC:
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8. Typical Connection

Analog 0-5V Speed Mode

The 5V output of DM805-AI is connected to the COM+. The input signal is activated when it is short circuit to the signal GND. When

the Limit switch is activated, the motor shaft will be free and the red indicator is on.

.

m (000000

LD
Accel/Ramp |:F' Accel
Decel/LoSpeed |:F| Decel

HiSpeed |:':| HiSpeed

COM+
Run/Stop/Pulse o) Ny
Direction/+Limit O o
Speed/(-)Limit g O i l
Enable/Disable | & O,
DMS&0O5-A1 Signal GND Disable
+5V Output
0~5V Input o sy
Signal GND
Signal GND
|
Power GND | @3
4+20-80VDC 20-80VDC
Motor A+
Motor A- /
Motor B+ [ Motor
Motor B- \
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Low/High Speed Mode

U

t‘ (0000000

Accel/Ramp [ P| Ramp
DecelLoSpeed| | LoSpeed

HiSpeed[ | HiSpeed

COM+
Run/Stop/Pulse | & ORun/Stop
Direction/+Limit © Direction
Speed/(-)Limit OSpeed
Enable/Disable m l
DM 8 O 5 - AI Signal GND | &
+5V Output
0~5V Input
Signal GND
Signal GND
|
Power GND 20-80VDC
+20-80VDC | &
Motor A+ 7
Motor A- (
Motor B+ \ Motor
Motor B-

a
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External Potentiometer Mode

U

(0000

U
]

LD
Accel/Ramp I:F' Accel
Decel/LoSpeed I:P Decel

HiSpeed I:'j HiSpeed

COM+
Run/Stop/Pulse| & 0 Ny
Direction/+Limit

Speed/(-)Limit

S _Limit-i-Limit
DMSO0S.AL e SHowe] |

+5V Output o
0~5V Input 0-2.5V Negative
Signal GND 10k 255V positive
Signal GND
I

Power GND 20-80VDC
+20-80VDC

Motor A+ /

Motor A- (

Motor B+ \ Motor

Motor B-
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Pulse/Direction Mode

A complete stepping system should include stepping motor, stepping drive, power supply and controller (pulse generator).

g g
|_| aonnnnnn

L

COM+ sy
Run/Stop/Pulse o
Direction/+Limit I
Speed/-Limit | @ .
Enal‘i)le/Disable Disable
DMS805-AI  “Siics
+5V Output
0~5V Input
Signal GND | @
Tach Output
I
Power GND | @& 50-80VDC
+20-80VDC | &
Motor A+
Motor A-
Motor B+ | & Motor
Motor B-

n

9. Wiring Notes

®  [n order to improve anti-interference performance of the drive, it is recommended to use twisted pair shield cable.

®  To prevent noise incurred in PUL/DIR signal, pulse/direction signal wires and motor wires should not be tied up together. It is
better to separate them by at least 10 cm, otherwise the disturbing signals generated by motor will easily disturb pulse direction

signals, causing motor position error, system instability and other failures.
® [fapower supply serves several drives, separately connecting the drives is recommended instead of daisy-chaining.

® [t is prohibited to pull and plug connector P2 while the drive is powered ON, because there is high current flowing through motor
coils (even when motor is at standstill). Pulling or plugging connector P2 with power on will cause extremely high back-EMF

voltage surge, which may damage the drive.
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10. Configure the Drive

The DMS805-AI uses an 8-bit DIP switch to set operating mode, microstep resolution and motor operating current as follows. The
dynamic current setting by SW1, SW2 and SW3 is active for all operating mode. The microstep resolution setting by SW5 and SW6
only takes effect in Pulse/Direction mode. SW4 is used to set the idle current and auto-configure the drive when it is first time

installation.

8-bit DIP Switch Function

Microstep Resolution

Dynamic Current Operating Mode

— s

Auto-Configuration / Idle-Current

Auto Configuration by SW4

To get the optimized performance, switch SW4 two times in one second to identify the motor parameter after power-up if it is the first
time installation. The motor parameter is identified and the drive’s current loop parameters are calculated automatically when SW4 is
activated. The motor shaft will have a little vibration during auto-configuration. If the user changes the motor or the power supply, don’t

forget to activate SW4 once again.

Sometimes the result of the auto-configuration is not good. This will happen to the stepper motor with large inductance or resistance.

The user needs to tune the current loop parameter manually. Please refer to the software manual of the DM805-AL.

Auto configuration:
Switch SW4 two times in one second.
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Selecting Operating Mode

Mode SW7 SW8 Description
0~5V Speed on on Analog 0-5V Speed Mode
Lo/Hi Speed off on Low and High Speed Mode
External POT on off External Potentiometer Speed Mode
Pulse/Direction oft oft Pulse and Direction Position Mode

Note: Remove power supply before changing operating mode.

Microstep Resolution Selection

In Pulse/Direction mode, microstep resolution is selected by SW4 and SWS5. The stepper motor moves one step when one pulse is
applied to the stepper drive. If microstep is 1, the step angle is a full step which is 1.8 degree for 2-phase stepper motor and 1.2 degree
for 3-hpase stepper motor. Microstep can be taken as the divisions of one full step. For example, stepper motor moves half of the full
step when the microstep is 2. For 2-phase stepper motor and drive, we have the following formula to calculate the microstep resolution,

or pulse counts of one motor shaft revolution:

Microstep  Resolution = 200 x Microstep

The motor speed can be calculated as follows:

Pulse Input Frequency

Motor  Speed RPS) = ¢

Microstep  Re solution

When selecting the drive’s microstep resolution for the system:

0  Consider the MAX speed needed, MAX input frequency of driver and MAX output frequency of the controller.
[0 1600 pulses/revolution (8 Microstep) is suitable for most application.

[0 >1600 pulses/revolution only increase smoothness but not resolution.
O

For digital driver, Microstep resolution is not important.
Current Settings

Dynamic current setting

For a given motor, higher drive current will make the motor to output more torque, but at the same time causes more heating in the
motor and drive. Therefore, output current is generally set to be such that the motor will not overheat for long time operation. Since
parallel and serial connections of motor coils will significantly change resulting inductance and resistance, it is therefore important to set
drive output current depending on motor phase current, motor leads and connection methods. Phase current rating supplied by motor

manufacturer is important in selecting drive current, however the selection also depends on leads and connections.
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Idle current setting

When there is no pulse applied to the DM805-AI and the time exceeds the idle-time which can be configured via the PC based software,
the drive goes into idle status. SW4 is used to set the idle-current, OFF meaning that the motor coil current is automatic reduced, and

ON meaning that current is the same as the selected dynamic current.

By default, the current automatically reduced to 60% of the selected dynamic current two second after the last pulse. Theoretically, this
will reduce motor heating to 36% (due to P=I**R) of the original value. If the user wants to change the idle time and current reduction

rate, please consult the DM805-AI’s software manual.

11. Protection Functions

To improve reliability, the drive incorporates some built-in protection functions. The DM805-AI uses one RED LED to indicate what
protection has been activated. The periodic time of RED is 3 or 5 s (seconds), and how many times the RED turns on indicates what
protection has been activated. Because only one protection can be displayed by RED LED, so the drive will decide what error to

display according to their priorities. See the following Protection Indications table for displaying priorities.

Over-current Protection

Over-current protection will be activated when continuous current exceeds the limit or in case of short circuit between motor coils or

between motor coil and ground, and RED LED will turn on once within each periodic time.

Over-voltage Protection

When power supply voltage exceeds the limit, protection will be activated and RED LED will turn on twice within each periodic time.

Note: When above protections are active, the motor shaft will be free or the LED will blink. Reset the drive by repowering it to make it
function properly after removing above problems. Since there is no protection against power leads ( +, - ) reversal, it is critical to make

sure that power supply leads correctly connected to drive. Otherwise, the drive will be damaged instantly.

Protection Indications

Time(s) of
Priority Sequence wave of RED LED Description
ON
1™ 1 ﬁ Over-current protection

025 055

2nd D -~

J L

Over-voltage protection

—
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12. Frequently Asked Questions

In the event that your drive doesn’t operate properly, the first step is to identify whether the problem is electrical or mechanical in nature.
The next step is to isolate the system component that is causing the problem. As part of this process you may have to disconnect the
individual components that make up your system and verify that they operate independently. It is important to document each step in the
troubleshooting process. You may need this documentation to refer back to at a later date, and these details will greatly assist our

Technical Support staff in determining the problem should you need assistance.

Many of the problems that affect motion control systems can be traced to electrical noise, controller software errors, or mistake in

wiring.
Problem Symptoms and Possible Causes

Symptoms Possible Problems
No power
Microstep resolution setting is wrong
Motor is not rotating DIP switch current setting is wrong
Fault condition exists
The drive is disabled
Motor rotates in the wrong direction Motor phases may be connected in reverse
DIP switch current setting is wrong
The drive in fault

Something wrong with motor coil
Control signal is too weak
Control signal is interfered

Erratic motor motion Wrong motor connection
Something wrong with motor coil
Current setting is too small, losing steps
Current setting is too small
Motor is undersized for the application
Motor stalls during acceleration
Acceleration is set too high
Power supply voltage too low
Inadequate heat sinking / cooling

Excessive motor and drive heating Automatic current reduction function not being utilized

Current is set too high
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APPENDIX

Twelve Month Limited Warranty

Leadshine Technology Co., Ltd. warrants its products against defects in materials and workmanship for a period of 12 months from
shipment out of factory. During the warranty period, Leadshine will either, at its option, repair or replace products which proved to be
defective.

Exclusions

The above warranty does not extend to any product damaged by reasons of improper or inadequate handlings by customer, improper or
inadequate customer wirings, unauthorized modification or misuse, or operation beyond the electrical specifications of the product
and/or operation beyond environmental specifications for the product.

Obtaining Warranty Service

To obtain warranty service, a returned material authorization number (RMA) must be obtained from customer service at e-mail: before
returning product for service. Customer shall prepay shipping charges for products returned to Leadshine for warranty service, and
Leadshine shall pay for return of products to customer.

Warranty Limitations

Leadshine makes no other warranty, either expressed or implied, with respect to the product. Leadshine specifically disclaims the
implied warranties of merchantability and fitness for a particular purpose. Some jurisdictions do not allow limitations on how long and
implied warranty lasts, so the above limitation or exclusion may not apply to you. However, any implied warranty of merchantability or
fitness is limited to the 12-month duration of this written warranty.

Shipping Failed Product

If your product fail during the warranty period, e-mail customer service at to obtain a returned material authorization number (RMA)
before returning product for service. Please include a written description of the problem along with contact name and address. Send

failed product to distributor in your area or: Leadshine Technology Co., L.td. 3/F, Block 2, Nanyou Tianan Industrial Park, Nanshan Dist,

Shenzhen, China. Also enclose information regarding the circumstances prior to product failure.
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DMSOS-AI

Digital Stepper Drive with Analog 0-5V Input and Built-in Oscillator

Features

B Anti-Resonance, provides optimum torque and nulls mid-range instability

B Motor self-test and parameter auto-setup technology, offers optimum responses with
different motors

B Multi-Stepping allows a low resolution step input to produce a higher microstep

output for smooth system performance

Command Source: 0-5V, built-in potentiometer and pulse

Two preset velocity and adjust by built-in potentiometer

Preset acceleration/deceleration and adjust by built-in potentiometer

Velocity control mode via 0-5V and position control mode via pulse

Built-in pulse generator nulls external motion controller

Supply voltage up to +80 VDC

Output current programmable, from 0.3A -5.0A(RMS)

TTL compatible and optically isolated digital input

Automatic current reduction

Over-voltage, over-current, phase-error protections

Descriptions

The DM805-AI is a 0-5V input stepper drive with built-in oscillator which is based on the latest digital control algorithm. It brings a
unique level of system smoothness, providing optimum torque and nulls mid-range instability. Motor self-test and parameter auto-setup
technology offers optimum responses with different motors and easy-to-use. The driven motors can run with much smaller noise, lower
heating, smoother movement than most of the drivers in the markets. Its unique features make the DM8O05-AI an ideal solution for

applications that require low-speed smoothness.

The three built-in potentiometers are used to preset and adjust the velocity, acceleration and deceleration. In 0-5V speed mode, the motor
speed is controllable and follows the analog 0-5V input. In high/low speed mode, the motor speed is selected by digital input and adjusted
by the high/low speed potentiometers. The user can run the motor with the least configuration and connection. In position mode, the

DMS805-ALl is a traditional stepper drive. There is a 5V power supply output for customer use.

Applications

This drive is suitable for the application which needs to adjust the velocity via the potentiometer or analog 0-5V command. It can work
with the NEMA17/23/34 stepper motor to replace the brushless motor with gearbox due to its high torque and less motor noise at low
speed. If necessary, it can be used in various kinds of machines, such as rotary heat exchange, conveyor belts, transport vehicle, laser

cutters, laser markers, high precision X-Y tables, labeling machines, and so on.
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Specifications

Electrical Specifications

Parameter Min Typical Max Unit
Input Voltage 18 60 80 VDC
Pulse Input Frequency 0 - 200 kHz
Logic Signal Current 7 10 16 mA
Isolation Resistance 500 - - MQ
Velocity Control
Item Specification = Dead Band Resolution Min Max
Analog 0-5V Speed Mode 10 mV
0-5V 10 mV 0 Rev/s 25+ 0.5 Rev/s
Input External POT Mode 20 mV
Accel / Decel / Ramp Potentiometer 0-25 turns 10 mV 10 mV 0.5 Rev/s” 250 £ 1 Rev/s®
LoSpeed Potentiometer 0-25 turns 10 mV 10 mV 0 Rev/s 5%0.01 Rev/s
HiSpeed Potentiometer 0-25 turns 10 mV 10 mV 0 Rev/s 25+ 0.5 Rev/s
Operating Environment
Cooling Natural Cooling or Forced cooling
Environment Avoid dust, oil fog and corrosive gases
Ambient Temperature 0°C — 50°C (32°F — 122°F)
Operating Humidity 40%RH — 90%RH
Environment Operati
perating 70°C (158°F) Max
Temperature
Vibration 5.9m/s” Max
Storage Temperature -20°C — 65°C (-4°F — 149°F)
Weight 350g (12.340z)
Mechanical Specifications
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Drive Interface

Indicator Green: Power, Red: Fault

Potentiometers Adjusting Speed, Acceleration and Deceleration

Digital I/O Signal Connector, 6-pin screw terminal, 3.81 mm space

Analog Signal Connector, 6-pin screw terminal, 3.81 mm space

Power Connector, 6-pin screw terminal, 3.81 mm space

Auto Tuning: Switch SW4 two times in one second.

RS232 communication port, RJ11, communicating PC software
Note: It is used to configure and current loop tuning, anti-resonance
tuning with the PC software. However, the drive can still work

properly without it. The DMS805-AI can be fully tuned by the

auto-tuning.

DIP switch, 8 bits, current setting, selecting microstep, operating mode

Protection Indications

Priority Time(s) of ON Sequence wave of RED LED Description

I 1 |—|Lu_s'1
ond 2 Lﬂiﬁuﬂ

55

Over-current protection

55 ‘

Over-voltage protection

[

Connectors and Pin Assignment

The DM805-AI has three connectors, connector for digital I/O signals connections, connector for analog 0-5V signal connections
and connector for power and motor connections. The three parameters are used to preset or adjust the speed, acceleration and
deceleration ramp. They have different functions in different modes. The green indicator turns on when the drive is powered on.

When error happens, the red indicator flashes periodicity to indicate the error type.

I/O Signal Assignment in Different Mode

I/O Signal 0-5V Speed Mode Lo/Hi Speed Mode External POT mode Pulse/Direction
Run/Stop/Pulse Run/Stop Run/Stop Run/Stop Pulse
Direction / +Limit Direction Direction +Limit Direction
Speed / (-)Limit -Limit Speed -Limit N/A

(021) 33913364 - 33951660 : wsli ¢f
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Digital I/O Signal Connector
6-pin screw terminal, 3.81 mm space
Pin Name /0 Description
1 COM+ Power +5V Power Input, common reference of all inputs
Run/Stop signal for 0-5V analog, Lo/Hi Speed and External POT
2 Run/Stop/Pulse I
mode. In Pulse/Direction mode, it accepts pulse input.
Direction input for 0-5V analog, Lo/Hi Speed and Pulse/Direction
mode. It is the +limit switch input in External POT mode. When
3 Direction / +Limit 1 +Limit is activated, the motor speed decelerates to zero in the
acceleration set by Ramp potentiometer. The +Limit is only activated
when the voltage applied to 0-5V input is 2.5-5V.
Speed selection input in Lo/Hi speed mode. It is the -limit switch
mput in External POT and 0-5V Speed mode. When +Limit is
activated, the motor speed decelerates to zero in the acceleration set
4 Speed / (-)Limit I by Ramp potentiometer. In External POT mode, the —Limit is
activated only when the voltage applied to 0-5V input is 0-2.5V. In
0-5V speed mode, the -Limit is activated only when Direction input
is connected to Signal GND.
5 Enable / Disable . This signal is used to enable or disable the power stage. Usually left it

unconnected to enable the power stage.

6 Signal GND GND Signal ground. It is common with the power ground.

Analog Signal Connector

4-pin screw terminal, 3.81 mm space

Pin Name /O Description
1 +5V Output O +5V Power Output, reference to signal ground
2 0-5V Input I Analog 0-5V reference input
3 Signal GND GND Signal ground. It is common with the power ground.
4 Signal GND GND Signal ground. It is common with the power ground.

Power Connector

6-pin screw terminal, 3.81 mm space

Pin Name /0 Description
1 Power GND GND Power ground
2 TS ’ Power supply input, 24-72VDC recommended, leaving rooms for voltage
fluctuation and back-EMF.

3 Motor A+ o Motor Phase A+

4 Motor A- o Motor Phase A-

S Motor B+ o Motor Phase B+

6 Motor B- o Motor Phase B-

D site : www.10BC.com
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DIP Switch Settings
Operating Mode
Mode SW7 SW8 Description
0~5V Speed on on Analog 0-5V Speed Mode
Lo/Hi Speed off on Low and High Speed Mode
External POT on off External Potentiometer Speed Mode
Pulse/Direction off off Pulse and Direction Position Mode

Note: Can not change mode on-the-fly and need to repower the drive.

Dynamic Current

PEAK RMS SW1 SW2 SW3

Default Default off off off
2.6A 1.8A on off off
3.4A 2.8A off on off
4.0A 2.4A on on off
4.8A 3.4A off off on
5.4A 3.8A on off on
6.1A 4.3A off on on
7.0A 5.0A on on on

Note: Due to motor inductance, the actual current in the coil may be smaller than the dynamic current setting, particularly under high

speed condition.

Microstep Resolution

Pulses/Rev. SW5 SW6é
Default on on
400 off on
1600 on off
12800 off off

Note: It is only active in Pulse/Direction mode.
Idle-Current

SW4 decides the idle current is reduced automatic or remains the same as the dynamic current setting.

ON OFF
The motor idle current reduces automatically The motor idle current is the same as the
SW4 when there is no pulse applied to the DM805-AL dynamic current when there is no pulse applied

to the DM805-AL

Auto Configuration by SW4

Switch SW4 two times in one second to auto-configure the drive’s current loop parameter.
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Potentiometers
Potentiometer 0-5V Speed Mode
Accel / Ramp Acceleration
Decel / LoSpeed Deceleration
HiSpeed High Speed

RS232 Communication Port

It is used to configure and current loop tuning, anti-resonance tuning with the PC software. However, the drive can still work

Lo/Hi Speed Mode

External POT mode
Acceleration
Deceleration

High Speed

properly without it. The DM805-AI can be fully configured by the auto-tuning by DIP switch SW4.

Typical Connections

0-5V Speed Mode

U
]

COM+
Run/Stop/Pulse
Directi

i
Accel/Ramp [ P| Accel

Decel/LoSpeed [ P| Decel
HiSpeed l:P HiSpeed

ir n/+Limit
Speed/(-)Limit
Enable/Disable

+5V Output
0~5V Input
Signal GND
Signal GND

Power GND
+20-80VDC
Motor A+
Motor A-
Motor B+
Motor B-

n_® n

DMSOS-AI Signal GND L@

O
b Run'Stop
-4 © Direction
J -Limit
AR !
Disable

o)
<

i

20-80VDC

/\@

External POT Mode

U
1]

COM+

[ [
Accel/Ramp [P Accel
Decel/LoSpeed [ 1 Decel

HiSpeed [ 1 HiSpeed

p/Pul
Direction/+Limit
Speed/(-)Limit
Enable/Disable

DMS805-AT  “Sies

+5V Output
0~5V Input
Signal GND
Signal GND

Power GND
+20-80VDC
Motor A+
Motor A-
Motor B+
Motor B-

n® N

Run/Stop
+Limit
-Limit
s

|s08998]

20-80VDC

— |epsses|
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Pulse/Direction

N/A
N/A
N/A

Low/High Speed Mode

U
]

U
i

Accel/Ramp[__P| Ramp
DecelLoSpeed[ | LoSpeed
HiSpeed[—_p|  HiSpeed

COM+
Run/Stop/Pulse
Direction/+Limit
Speed/(-)Limit
Enable/Disable

DMS805-AL  semaw

+5V Output
0~5V Input
Signal GND
Signal GND

Power GND
+20-80VDC
Motor A+
Motor A-
Motor B+
Motor B-

n® n

e
= Run/Stop
<4 Direction
4 Speed
oo |
—
@+
@
@
@
p— —
4l 20-80VDC

[ Motor
—f

Pulse/Direction Mode

0-2.5V Negative
4 10k 255V positive

U
]

U
.

Accel/Ramp[__P| Ramp
DecelLoSpeed[ |  LoSpeed

HiSpecd[ | HiSpeed

COM+

R ul
Direction/+Limit
Speed/(-)Limit
Enable/Disable

DMS805-Al  semaw

+5V Output
0~5V Input
Signal GND
Signal GND

Power GND
+20-80VDC
Motor A+
Motor A-
Motor B+
Motor B-

Run/Stop
Direction
Speed
s

sllzerses

s

20-80VDC

r@
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Introduction

The ProTuner for DM805-AI is a software tool designed to configure and tune the Leadshine digital drive DM805-AI. The user can tune

the current loop and adjust the anti-resonance parameters in this software.

Workspace

After installing the software and open it, the software is displayed as follows.

Menu

Tuning
and

Property

Menus and Toolbar

Menu is at the top of the workspace. You can click menu bar to view the pull-down menu.

Menu Pull Down Function
Open Open a file

File -> Save As Save as a file
Exit Exit ProTuner

(021) 33913364 - 33951660
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Menu Pull Down Function
Error Log Check the error log
View ->
Drive Information DMS805-AlI specification
Connect to Drive Connect to drive
Current Loop Tuning Set current loop parameters Kp and Ki and test.
Property Set drive properties like I/O logic, motor parameters.
Drive->
Offset Check analog and potentiometer offset
Save to Drive Save all data to drive
Restore Factory Setting Restore factory setting
Help-> About Software Information

Using the Software

Opening a file

If you want to reload the configuration data from a file in the PC, click on the File->Open. The parameters in the software’s workspace

will be updated

Save as a file

Save the data in current workspace to a file and rename it.
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Connecting to Drive Window

Connect to Drive E|

Chooze Senal Part ;

IEEIM'I vl

Choose Baudrate:

| 33400 =l

Connect to Drive window appears when you open the software. Choose correct serial port and leave the baud rate as default 38400. The

software will try to connect to the drive after you click on the Open button.

Before clicking on the Open button, please make sure:
1) The RS232 cable .has been connected between the drive and the PC’s serial port.
2) The drive has been powered on and the green LED is turned on.

The stepper motor is unnecessary connecting to the drive if you just want to set the parameters but not tuning.

Do not connect or disconnect serial cable when the drive is powered on. The drive’s communication circuit may be
damaged.

Current loop tuning Window

PT Current Loop Tuning |z|

[ L

Proportionalﬁain:lzauz Integral Gain: 196 TestVaIue:Il Test |

It is used to configure current loop parameters according to different motor. In the tuning window, user can set proportional gain, integral

gain and test value.
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After finishing the input of the number, don’t forget to hit the “Enter” key in the keyboard to confirm new value.

Item Description Range

Increase this parameter to make current rise fast. Proportional Gain
determines the response of the driver to current setting command. Low
Proportional Gain provides a stable system (doesn’t oscillate), has low
Proportional Gain . ) . . 1-65535
stiffness, and large current error, causing poor performances in tracking
current setting command in each step. Too large Proportional Gain

values will cause oscillations and unstable systems.

Adjust this parameter to reduce the steady error. Integral Gain helps the
driver to overcome static current errors. A low or zero value for the

Integral Gain Integral Gain may have current errors at rest. Increasing the Integral 1—65535
Gain can reduce the error. If the Integral Gain is too large, the systems

may “hunt” (oscillate) about the desired position.

Test Value The current amplitude for the step response. 05-5A

Click this button to activate the test. A target curve (red) and an actual

Test Button . . ) -
curve (green) will be displayed on the screen for user analysis.
Property Window
PT Drive Property

—Anti-resonance Tuning
~ The 13t Resonance Area

Armplitude ; 76 )
Phase : 1258 . . . . = . = . j

— The 2nd Resonance Area

-

Armplitude: : ID
Phase : |IJ

-

— The 3rd Resonance Area

Amplitude ; I'I 28

S
Phase:  [128 : : ) . s . . . :
— Motor
Dynamic Current: [2 50 A Microstep : |1 Electronic Damping : |1DDD
Stop Mode
’V % Decelerated Stop  Immediate Stop

The user can set the drive’s anti-resonance parameters, output current, microstep, electronic damping and stop mode according the motor

and application.

Microstep setting is only effective in Pulse/Direction mode.
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Item Description Range
The 1st Resonance Area It is usually between 0.6 to 1.2 RPS. -
The 2nd Resonance Area It is usually between 1.2 to 2.4 RPS. -
The 3rd Resonance Area It is usually between 2.4 to 4.8 RPS. -

Amplitude adjustment for anti-resonance tuning. 0 — 3500 for

the 1%, 2™ resonance area and 0- 256 for the 3rd resonance area. 0 — 3500 or 0O-
Amplitude . .
The user can enter a value directly in the text box or move the 256
slider bar back and forth to get an optimum value.
Phase adjustment for anti-resonance tuning. The user can enter a
) ) ) 0 — 1608 or 0-
Phase value directly in the text box or move the slider bar back and 556

forth to get an optimum value.

Drive’s output current setting according to the motor. It should
be less than the motor’s related current * 1.414.

Dynamic Current 0.5-7.0A
Note: The DIP switch setting must be SW1 = off, SW2 = off,

SW3 = off if you wan to set this parameter in ProTuner.

Drive’s Microstep setting for the motor.
Notel: The DIP switch setting must be SW5 = off, SW6 = off,

MicroStep SW7 = off, SW8 = off if you wan to set this parameter in 1-512
ProTuner.

Note2: The microstep is effective only in Pulse/Direction mode.

Adjust this parameter to improve the drive’s high speed
Electronic Damping ) 0 - 6000
performance. The optimal value depends on the system.

The motor stops immediately when a stop command is applied
to the drive if this parameter is immediate stop. Otherwise the

Stop Mode ) ] -
motor stops with a acceleration set by the Accel/Ramp or

Decel/LoSpeed potentiometers.
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Offset

BT of£set |X

Analog 0-5Y Speed Mode I;-';f—
External POT tode : W

Accel / Bamp Potentiometer : IU—
Decel / LoSpeed Potentiometer : IU—
HiSpeed Potentiometer : |4—

It is used to check the offset of the potentiometers and analog input in factory. The user can ignore it.

Save to Drive

After the drive’s configuration and tuning is done, you need to click Drive->Save To Drive to save the data to drive’s nonvolatile

memory. Otherwise the data will not be lost after power-off.

Restore Factory Setting

This command is used to restore the factory data when the drive is out of control or the user want to do that.

Configuring the drive

If it is the first time setup, you can follow the steps below to configure the drive.

1)  Set motor related parameters such as dynamic current, microstep and stop mode according to the motor and application.
2)  Tune the current loop parameters.

3) Tune the anti-resonance parameters if necessary.

4) Adjust the electronic damping when the high speed performance is not good.

A The motor must be connected to the drive before trying to configure the drive.

A After finishing the input of the number, don’t forget to hit the “Enter” key in the keyboard to confirm new value
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Set motor related parameters

Click Drive->Property to open the Property window. You can set the motor’s dynamic current, microstep and stop mode.

Maotor

Dynamic Current : [3.00 A Microstep |3 Electranic Damping : {1000
Stop Mode

’V i+ Decelerated Stop " Immediate Stop

The motor’s dynamic current is related to the related current. Usually, the motor manufacturer states the RMS (root mean square) current

in datasheet. Please relate to the hardware installation manual for how to set the dynamic current.

A The DIP switch setting must be SW1 = off, SW2 = off, SW3 = off if you wan to set this parameter in ProTuner.

The microstep is so important is only effective in Pulse and Direction command mode. High resolution microstep makes the motor move

more smoothly. Low microstep resolution reduces the high frequency requirement to the controller.

g 1. The DIP switch setting must be SW5 = off, SW6 = off, SW7 = off, SW8 = off if you wan to set this parameter in

ProTuner.
2. The microstep is effective only in Pulse/Direction mode.

The motor stops in the acceleration set by the potentiometer. If the application needs fast stop, please click Immediate Stop.
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Tune the current loop

The DM805-ATI’s current loop need to be tuned before normal operation in order to get optimize responses with different motors.
Otherwise the motor will be easily stall or howls when power-up. Below is the tuning process for a NEMA 23 motor with 24VDC

supply voltage.

Step 1: Set Test Value 1 and start the tuning with small Proportional Gain and “zero” Integral Gain. Here we set Proportional Gain
500.

FT Current Loop Tuning

Initial Value

Proportional Gain = 500
Integral Gain =1

Proportional Gain : ISDD Inteqral Gain : |1 Test Value : |1 Test |

Step 2: Click the Test button and the plot window will show two curves. The red one is target current and the green one is actual

current. There is large gap between them in the scope. It indicates that a large Proportional Gain needs to be introduced.

PT Current Loop Tuning

Start Test:

Proportional Gain = 500
Integral Gain =1

F'rnp-:-rti-:-nalGain:lSDD Integral Gain : |1 Test\r‘alue:ll Test |

Step 3: Increase Proportional Gain to 1000 and click Start. The gap between target value and actual value is smaller but a higher

Proportional Gain is still needed.
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PT current Loop Tuning | |

\,_; t  Proportional Gain:

Proportional Gain = 1000

Integral Gain =0

PloportionalGain:llDDD Integral Gain |1 Test\-"alue:ll Test |

Step 3: Give Proportional Gain 2000, 3000, 4000 and click Test button, respectively. The green curve is getting more and more close
to the red curve. Over-shoot is obvious when we increase Proportional Gain to 4000. It indicates that you need to stop increasing Kp
and back off. Our purpose is to make the green curve (the actual current) a little higher than the red curve (the target). So we decrease

Kp to 3700 until the actual value is exactly over the target value.

FT Current Loop Tuning |X|

[’ k t Proportional Gain:

Proportional Gain =2000

Integral Gain =1

Propaortional Gain : IZDDD Integral Gain : |1 Test Walue : |1 Test |

FT Current Loop Tuning |z|

f \ t  Proportional Gain:

Proportional Gain =3000
Integral Gain =1

PropnrtionalGain:lSDDD Integral Gain : |1 Te&t\-"alue:ll Test |
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FT Current Loop Tuning

\ t Proportional Gain:

J \ - Proportional Gain =4000

I~

Over-Shoot

Integral Gain =1

PropnrtinnaIGain:IetDDD Inteqral Gain : |1 Test\-"alue:ll Test |

PT current Loop Tuning |5|

, \ V Proportional Gain:

Proportional Gain =3700
Integral Gain =1

PropnrtinnalGain:lSTDD Integral Gain : |1 Te&t\-"alue:ll Test |

Step 4: Now the Proportional Gain is relatively good enough. But there is still gap between the green curve and the red curve when
we use the mouse to zoom in the green curve. So we need to introduce Integral Gain to reduce the “gap” or steady error at the constant

part. It follows the same procedure as Proportional Gain. High Integral Gain causes big vibration, system lag and makes the

performance worse. The following figures show how to tune the integral gain.

PT Current Loop Tuning |z|

S S S— Zh

Drag a triangle to zoom in

PropnrtinnalGain:lSTDD Integral Gain : |1 Te&t\-"alue:ll Test |
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FT Current Loop Tuning

Zero Integral Gain:

¥ Proportional Gain =3700
Integral Gain =1

ProportionalGain:lSTUD Inteqgral Gain |1 TeslVaIue:Il Test |

FT Current Loop Tuning |z|

MWU\W t Integral Gain:

Proportional Gain =3700
Integral Gain =200

Proportional Gain : ISTDD Integral Gain : |2|:||3 Test Value : |1 Test |

PT Current Loop Tuning |z|

t Integral Gain:

B RV Y S LTV A YA WS
\VM Proportional Gain =3700

Integral Gain = 400

PlopoltionalGain:lSTDD Integral Gain : |4|:||3 TestVaIue:Il Test |

Step 5: The current loop tuning is basically finished. You can continue to adjust Kp and Ki for better performance. Now the updated
Kp and Ki is just stored in the driver’s RAM. They will be lost when we power off the driver. Don’t forget to click Drive->Save To
Drive to store the changed value to the drive’s EEPROM.
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PT Current Loop Tuning

Further Adjustment:

Proportional Gain =3500
Integral Gain = 300

Propartional Gain : ISSDD Integral Gain: 300 Test Value : |1 Test |

Save all the changes to the drive’s

non-violated nonvolatile memory.

1

Anti-resonance Tuning

Step motors are highly resonant, which results in vibration and ringing. The ringing utilizes a large fraction of the motor's available
torque — thereby wasting performance. Furthermore, at mid-range velocities, the resonance can become so severe that the motor looses
synchronization and stalls. The DM442 drive provides robust anti-resonance control to stop the vibrations and maintain equilibrium.
This feature requires that the drive be configured with respect to the total inertia in the system. If set improperly, the effectiveness of the

feature may be diminished.

1. For most of the application, it is not needed to tune DM805-AI’s anti-resonance parameters. We only recommend the
A advance user to use this function as it is a boring process.

2. Inmost of the case, only the tuning of the 1*' and 2™ anti-resonance area has obvious effect.

Step 1: Connect the drive as follows and configure it in Low/High Speed mode by set SW7 = OFF and SW8 = ON. As the Speed input
is connected to Signal GND, the motor speed is determined by the LoSpeed potentiometer and it can be adjusted from ORPS to SRPS.

D site : www.10BC.com

R4 Email : Borhan772000@yahoo.com
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Step 2: Start to move the motor by activating the Run/Stop input. Find a resonance speed by slightly adjusting the LoSpeed parameter

20-80VDC

—sssss0/lesssfessens

CW and CCW.

Step 3: Keep the motor running at the resonance  speed and verify the motor smoothness. Y ou may find a better smoothing value by
slightly moving the slider bars of Amplitude and Phase back and forth. If the motor speed is 0.6-1.2RPS, you should tune the Amplitude

and Phase at the 1% resonance area. The 2™ resonance area is 1.2-2.4 RPS and the 3" resonance area is 2.4 4.8 RPS.

1. You can calculate the motor speed roughly as follows:

A Turns of LoSpeed  Potentiometer

Speed(RPS) = 5x0.01(RPS) x
25Turns

2. It is very important to make the Amplitude and Phase adjustments at the resonance speed.

For example, we find a resonance speed at 0.98 RPS. We begin to move the Amp1 slider forth and the motor vibration and noise be came

lower and lower. Finally we find ~ the move is the smoothest when ~ Amplitude is 3300. The motor vibrat ion and noise increase if

Amplitude exceeds 3300. Then we follow the same procedure to search the best point for Phase. See Figure 26. Anti-resonance tuning is

done.

Step 4: Click Drive->Save To Drive to save all the parameters to DM805-AL

Adjusting the Electronic Damping

The factory setting for the electronic damping is 1000. If the mo tor is easily stalled and generates odd noise at middle speed, you can try

other values such as 500, 1500, 2000, 2500.

(021) 33913364 - 33951660 : wsli ¢f
(021) 33985603 : uuSS PR
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